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使用之前

2警告

为了防止受伤或火灾，请遵守下列注意事项: 
· 为了防止短路等事故，请勿将金属物品 (硬币、工
具等) 掉落在装置中。

在首次使用本机之前
本机在出厂时被设定为演示模式。
首次使用本机时，请取消演示模式。请参照 <退出演
示模式> (第4页)。

本机的复位方法
· 如果本机无法正常工作，请按下复位按钮。按下复
位按钮后，本机恢复到出厂设定状态。

 

复位按钮

本机的清洁方法
如果本机的面板肮脏，请使用干净柔软的干布 (例如
硅布) 等擦拭清洁。
如果面板肮脏的程度严重，请先使用布蘸中性清洁剂
擦拭，然后再次使用干净柔软的干布擦拭。
对本机直接喷洒清洁剂将可能使得机械部件受到影
响。如果使用硬质的布或者使用诸如稀释剂或酒精
等挥发性溶剂擦拭面板，则可能划伤表面或者将字
符擦掉。

本机和面板的端子
· 为了防止劣化，请不要用手触摸本机和面板的端
子。

· 如果本机或面板的端子弄脏，请使用清洁、干燥的
软布擦拭。

透镜雾气
在寒冷的天气使用汽车暖气时，本机的CD播放器透镜
可能发生雾气或结露，称为透镜雾气，透镜上的结露
可能影响CD播放。这时，请取出光盘等候结露蒸发。
如果等一会后本机仍然无法正常运行，请与当地的建
伍经销商洽询。

说明
· 安装发生困难时，请与建伍经销商洽谈。

· 当购买选购附件时，请与建伍经销商洽谈，确认选
购附件是否适合您的机型以及能否在您的地区使
用。

· 可显示符合ISO 8859-1的字符。
· 为了使用下列语言显示字符，需要另行设定。

 KDC-U7046BT   KDC-U6046 
- 中国语
请参照 <功能设定> (第15页) 的 32 中文语言设定。

  KDC-U7046BTL   KDC-U6046L 

- 阿拉伯语
- 波斯语
- 泰语
请参照<功能设定> (第15页) 的 33 语言设定。

· 在本说明书中采用的显示和面板的插图是为了更加
明确地举例说明控制的使用方法。因此，在插图中
出现的显示可能与实际装置的显示有所不同，并且
某些显示的插图可能不适用。

 CD的使用
· 手持CD时，请不要触摸CD的记录面。

· 请勿向CD粘贴胶带等。并且请不要使用粘贴了胶
带的CD。

· 请不要使用光盘用附件。

· 请从光盘的中心向外侧擦拭。

· 将CD从本机中取出时，请向水平方向拉出。

· 当CD的中心孔以及外侧圆周部位有毛刺时，请使
用圆珠笔等将毛刺去除，然后再使用。

无法使用的CD
· 无法使用圆形以外的CD。

· 无法使用记录面著色的CD以及肮脏的CD。

· 本机仅能够播放具备下列标志  的
CD。
对于没有这些标志的CD，本机可能无法正常播
放。

· 没有进行过最终处理的CD-R以及CD-RW无法播
放。(有关最终处理的详细内容，请参照所使用的
CD-R/CD-RW记录软件和CD-R/CD-RW记录器的使用
说明书。)

· 无法使用3英寸CD。如果试图使用适配器插入将导
致故障。
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基本操作

使用之前

 退出演示模式

安装后第一次使用本机时，请取消演示模式。

1 在显示 "To Cancel DEMO Press the ENTER Key" 
(请按ENTER键取消演示模式) 时 (约15秒)，请按下 

[ENTER] 按钮取消演示模式。

2 旋转控制旋钮选择 "YES" (是)，然后按下 [ENTER]
按钮。

演示模式也可以通过功能设定模式取消。

请参照<功能设定> (第15页) 的 40 演示模式。

 

 调节时钟和日期

1 按下 [FNC] 按钮进入功能设定模式。
2 可选择和确定以下项目。
"Settings" (设定) ➜ "Clock & Date" ➜

"Clock Adjust"

选择项目时，旋转控制旋钮。确定项目时，按下 

[ENTER] 按钮。

3 旋转控制旋钮调节小时，然后按下 [ENTER] 按钮。
4 旋转控制旋钮调节分钟，然后按下 [ENTER] 按钮。
5 旋转控制旋钮选择 "Date Adjust"，然后按下 
[ENTER] 按钮。

6 旋转控制旋钮调节年，然后按下 [ENTER] 按钮。
7 旋转控制旋钮调节月，然后按下 [ENTER] 按钮。
8 旋转控制旋钮调节日，然后按下 [ENTER] 按钮。
9 旋转控制旋钮选择 "Date Mode"，然后按下 
[ENTER] 按钮。

10 旋转控制旋钮选择日期格式，然后按下 [ENTER] 
按钮。

11 按下 [  ] 按钮1秒钟以上退出功能设定模式。

[FNC] [ENTER] [FAVORITE]

[DISP] [AUDIO]

[0][SRC][     ]

[     ] KDC-6046
KDC-6046L

KDC-6046
KDC-6046L

[       ]

KDC-7046BT
KDC-7046BTL

KDC-7046BT
KDC-7046BTL

[       ]

辅助输入控制旋钮

USB端子拆卸按钮
麦克风

光盘槽

 KDC-U7046BT 
 KDC-U7046BTL 

10Entry_stepup_M_CHS.indd   410Entry_stepup_M_CHS.indd   4 10/01/08   11:0510/01/08   11:05



中文   |   5

共通操作

 电源和选择信号源

按下 [SRC] 按钮接通电源。

电源接通后，选择信号源。

按下 [SRC] 按钮，然后旋转控制旋钮。确定选择的

信号源时，按下 [ENTER] 按钮。

调谐器 ("TUNER") ➜ Bluetooth音响 ("BT AUDIO") 

(仅限KDC-U7046BT/ KDC-U7046BTL) ➜ USB 

("USB") 或 iPod ("iPod") ➜ CD ("CD") ➜ 辅助输入 

("AUX") ➜ 待机 ("STANDBY") ➜ 调谐器...

按下[SRC]按钮1秒钟以上，电源切断。

⁄
· 可以选择信号源选择模式，每次按下 [SRC] 按钮，即在信

号源之间切换。请将 <功能设定> (第15页) 的 29 信号源选

择模式设定为 "2"。

· "iPod" 和 "CD" 信号源的播放准备就绪后，才可以选择该信

号源。

· 当连接了选购附件时，出现各装置的信号源名称。

音量

旋转控制旋钮调节音量。

滚动显示

 KDC-U6046   KDC-U6046L 

向下按住 [DISP] 按钮，滚动显示CD或音响文件

文本。

 KDC-U7046BT   KDC-U7046BTL 

向上按住控制旋钮，滚动显示CD或音响文件文

本。

辅助输入

可以使用立体声微型插头 (直径3.5mm) 连接携带

式音响装置。

播放音乐 (CD/USB/iPod)

播放光盘

向光盘槽插入光盘。

插入后信号源自动切换，开始播放歌曲。

播放USB装置

将USB装置或iPod与USB端子连接。

连接后信号源自动切换，开始播放歌曲。

选择音响文件夹

向上或向下按下控制旋钮选择文件夹。

选择歌曲

向右或向左按下控制旋钮选择歌曲 (音轨或文件)。

音乐的快进或快退

向右或向左按住控制旋钮，快进或快退含歌曲的音

响文件 (音轨或文件)。

暂停和播放

按下 [  ] 按钮，暂停或恢复播放歌曲 (音轨或

文件)。

取出光盘或拆下USB装置

按下 [0] 按钮弹出光盘。

按住该按钮2秒钟以上进入USB装置拆除模式 (显示 

"USB REMOVE")，然后可以安全地拆除USB装置。

⁄
· 建议使用CA-U1EX (选购附件) 连

接USB装置。 CA-U1EX

· 建议使用KCA-iP101 (选购附件) 连接iPod。

· 关于可播放的音响文件、装置、iPod，请参照 <附录> (第33

页)。

收听广播

选择调谐器信号源

1 按下 [SRC] 按钮。
2 旋转控制旋钮选择 "TUNER" (调谐器)，然后按下 
[ENTER] 按钮。

选择波段

向上按下控制旋钮，按照FM1 ➜ FM2 ➜ FM3的顺

序切换波段。

向下按下控制旋钮，切换到AM波段。

选择电台

向左或向右按下控制旋钮，选择需要收听的电台。

⁄
· 选择电台的具体操作，由 <功能设定> (第15页) 的 22 搜索

模式。

10Entry_stepup_M_CHS.indd   510Entry_stepup_M_CHS.indd   5 10/01/08   11:0510/01/08   11:05



6   |   KDC-U7046BT/ KDC-U6046/ KDC-U7046BTL/ KDC-U6046L

一般操作

拆卸面板

本机的面板可以拆下带走，便于防盗。

拆下面板

按下释放按钮。

重新安装面板

请参照下图重新安装面板。

¤
· 按下释放按钮后，请立即取下面板。如果面板没有取下，

则可能由于震动等落下。

· 面板是精密的设备部件，可能由于震动和颠簸而损坏。

· 面板拆下后，应保存在面板盒中。

· 不得将面板 (或面板盒) 暴露在直射的阳光下或者放在温度

过高或湿度过高的环境。并且应避免过多的灰尘和可能溅

到水。

KDC-U6046/ KDC-U6046L的功能

接收电话时对音量消音

接收电话时，音响系统自动消音。

接收电话时

显示 "CALL" (电话)。

音响系统暂停。

打电话时播放音响

按下 [SRC] 按钮。

 "CALL" (电话) 显示消失，音响系统恢复工作。

电话结束时

挂断电话。

 "CALL" (电话) 显示消失，音响系统恢复工作。

⁄
· 使用电话消音功能时，需要使用在市场销售的电话附件，

将消音导线与电话连接。请参照 <将导线与端子连接> (快

捷入门指南)。
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音响调节

⁄
 · ‡ "User" (用户设定): 用户设定的低音、中音和高音电平有
效。

· 可以对各信号源设定低音、中音、高音。

· 关于Supreme

对于使用低位速率 (低于128kbps、取样频率为44.1kHz) 编

码压缩的高频区域，采用专有运算法则进行推断和补充

的技术。

根据位速率，通过压缩格式 (AAC、MP3或WMA) 实现最

佳补充和处理。

对于使用高位速率、可变位速率编码的或具有最小限度高

频范围的音乐，该效果不明显。

· 关于双区域系统

主信号源和副信号源 (辅助输入) 分别从前侧声道和后侧

声道输出。

-  "2Zone" (双区域系统) 接通 ("ON") 时，主信号源和辅助

输入音响分别从前侧扬声器和后侧扬声器输出。

 -  通过 "2Zone" (双区域系统) 设置副信号源声道。

 -  通过 [SRC] 按钮选择主信号源。

 -  通过控制旋钮调节前侧声道音量。

 -  通过 "2Zone Rear Volume" (双区域系统后侧音量)调节后

侧声道的音量。

 -  音响控制对副信号源无效。

 -  如果选择了Bluetooth音响信号源，请将 "2Zone F/R 

Select" (双区域系统前/后侧选择) 设定到 "Rear" (后侧)。

如果设定到 "Front" (前侧)，"2Zone" (双区域系统) 无法

接通。"2Zone" (双区域系统) 接通 ("ON") 时，"2Zone F/R 

Select" (双区域系统前/后侧选择) 无效。

1 选择需要调节的信号源
按下 [SRC] 按钮。

关于信号源项目的选择方法，请参照 <电源和选择

信号源> (第5页)。

2 进入音响控制模式
 KDC-U6046   KDC-U6046L 

按下 [AUDIO] 按钮。

 KDC-U7046BT   KDC-U7046BTL 

1)  按下 [FNC] 按钮。

2)  旋转控制旋钮选择 "Audio Control"，然后按下 

[ENTER] 按钮。

3 选择需要调节的音响项目
旋转控制旋钮选择需要调节的音响项目，然后按下 

[ENTER] 按钮。

按下 [  ] 按钮返回至前一个项目。

4 调节音响项目
旋转控制旋钮。

5 确定设定值
按下 [ENTER] 按钮。

显示前一个项目。

6 退出音响控制模式
按下 [  ] 按钮1秒钟以上。

 音响控制

可以调节以下音响控制项目; 

显示 音频项目 范围

"SubWoofer" 重低音扬声器
输出

切断/接通

"Bass Boost" 低音提升 Level1 (1级)/Level2 (2
级)/OFF (切断)

"System Q" 预设均衡器曲线 "Rock" (摇滚乐)/"Pops" 
(流行音乐)/"Easy" (通俗
音乐)/"Top40" (顶尖40)/ 
"Jazz" (爵士乐)/"Game" 
(游戏)/"Natural" (自然音
乐)/"User"‡ (用户设定)

"Bass Adjust" 

"Bass Center 
FRQ" 

低音中心频率 40/50/60/70/80/100/ 
120/150 (Hz)

"Bass Level" 低音电平 -8 — +8 (dB)

"Bass Q Factor" 低音Q系数 1.00/1.25/1.50/2.00

"Bass EXT" 低音扩展 切断/接通

 "Middle Adjust" 

"Middle Center 
FRQ" 

中音中心频率 0.5/1.0/1.5/2.0 (kHz)

"Middle Level" 中音电平 -8 — +8 (dB)

"Middle Q 
Factor" 

中音Q系数 1.00/2.00

 "Treble Adjust" 

"Treble Center 
FRQ" 

高音中心频率 10.0/12.5/15.0/17.5 (kHz)

"Treble Level" 高音电平 -8 — +8 (dB)

"Balance" 平衡 左侧15 ─ 右侧15

"Fader" 衰减器 后侧15 ─ 前侧15

"2Zone Rear 
Volume" 

双区域系统接通
时的后侧音量

0 — 35

"SubWoofer Level" 重低音电平 -15 — +15 (dB)

"Detailed Settings" 

"HPF Front" 前侧高通滤波器 通过/40/60/80/100/ 
120/150/180/220 (Hz)

"HPF Rear" 后侧高通滤波器 通过/40/60/80/100/ 
120/150/180/220 (Hz)

"LPF 
SubWoofer" 

重低音扬声器低
通滤波器

50/60/80/100/120/
通过 (Hz)

"Subwoofer 
Phase" 

低音扬声器相位 反相(180°)/标准(0°)

"2Zone" 双区域系统 接通/切断

"2Zone F/R 
Select" 

双区域输出声道 后侧/前侧

"Supreme" Supreme设定 接通/切断

"Audio Preset" 音响预设存储† 呼出/存储

"Volume Offset 
ADJ" 

音量偏置 -8 — ±0 (dB)
(AUX: -8 — +8)

†   请参照 <音响预设存储> (第8页)、<音响预设呼出> (第
8页)。
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 音响预设呼出

呼出由 <音响预设存储> (第8页) 登录的音响设置。

1 选择信号源
按下 [SRC] 按钮。

关于信号源项目的选择方法，请参照 <电源和选择

信号源> (第5页)。

2 进入音响控制模式
 KDC-U6046   KDC-U6046L 

按下 [AUDIO] 按钮。

 KDC-U7046BT   KDC-U7046BTL 

1)  按下 [FNC] 按钮。

2)  旋转控制旋钮选择 "Audio Control"，然后按下 

[ENTER] 按钮。

3 选择音响预设存储模式
可选择和确定以下项目。

"Detailed Settings" (详细设定) ➜ "Audio Preset" 

(音响预设)

选择项目时，旋转控制旋钮。确定项目时，按下 

[ENTER] 按钮。

4 选择音响预设呼出
旋转控制旋钮选择 "Recall" (呼出)，然后按下 

[ENTER] 按钮。

5 旋转控制旋钮选择 "YES" (是)，然后按下 [ENTER] 
按钮。

显示 "Recall Completed" (呼出完成)。

6 退出音响控制模式
按下 [  ] 按钮1秒钟以上。

 音响预设存储

登录音响控制的设定值。

1 设置音响控制
设置 <音响控制> (第7页)。

2 进入音响控制模式
 KDC-U6046   KDC-U6046L 

按下 [AUDIO] 按钮。

 KDC-U7046BT   KDC-U7046BTL 

1)  按下[FNC]按钮。

2)  旋转控制旋钮选择 "Audio Control"，然后按下 

[ENTER] 按钮。

3 选择音响预设存储模式
可选择和确定以下项目。

"Detailed Settings" (详细设定) ➜ "Audio Preset" 

(音响预设)

选择项目时，旋转控制旋钮。确定项目时，按下 

[ENTER] 按钮。

4 选择音响预设存储
旋转控制旋钮选择 "Memory" (存储)，然后按下 

[ENTER] 按钮。

5 旋转控制旋钮选择 "YES" (是)，然后按下 [ENTER] 
按钮。

显示 "Memory Completed" (存储完成)。

6 退出音响控制模式
按下 [  ] 按钮1秒钟以上。

⁄
· 使用本功能时，本机必须接通电源1小时以上。

· 登录1对音响预设存储。无法按照音源登录。

· 当按下复位时，所有音源将被设定为登录的数值。

· 可登录以下项目。

"Bass Center FRQ" (低音中心频率), "Bass Level" (低音电

平), "Bass Q Factor" (低音Q系数), "Bass EXT" (低音扩展), 

"Middle Center FRQ" (中音中心频率), "Middle Level" (中音

电平), "Middle Q Factor" (中音Q系数), "Treble Center FRQ" 

(高音中心频率), "Treble Level" (高音电平), "SubWoofer 

Level" (重低音电平), "HPF Front" (前侧高通滤波器), "HPF 

Rear" (后侧高通滤波器), "LPF SubWoofer" 

(重低音扬声器低通滤波器), "Subwoofer Phase" (重低音低

音扬声器相位)

音响调节
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音乐光盘/音响文件的操作

音响文件/内置CD信号源的功能

 音乐搜索

从装置或正在播放的媒体中选择需要欣赏的音乐。

1 进入音乐搜索模式
按下 [  ] 按钮。
显示 "MUSICSEARCH" (音乐搜索)。

2 搜索音乐 
音响文件

操作分类 操作

在文件夹/文件之间移动 旋转控制旋钮。

选择文件夹/文件 按下 [ENTER] 按钮。

返回到前一个文件夹 按下 [ ] 按钮。

返回到根文件夹 向左按下控制控制旋钮1秒钟以上。

取消音乐搜索模式 按下 [ ] 按钮1秒钟以上。

¡ 标志: 音响文件

] 标志:  在低层级含文件夹或文件的文件夹

^ 标志:  在低层级不含文件夹或文件的文件夹

CD信号源

操作分类 操作

音轨之间的移动 旋转控制旋钮。

选择音轨 按下 [ENTER] 按钮。

返回第一音轨 向左按下控制控制旋钮1秒钟以上。

取消音乐搜索模式 按下 [ ] 按钮。

⁄
· 如果歌曲名称中不含可显示的字符，则显示浏览项目名称

和数字。

项目 显示 项目 显示

播放列表 "PLIST***" 播客 "PDCT***" 

艺术家 "ART***" 流派 "GEN***" 

专辑 "ALB***" 作曲家 "COM***" 

歌曲 "PRGM***" 

iPod信号源的功能

 搜索iPod中的音乐

搜索需要播放的歌曲 (在iPod中)。

1 进入音乐搜索模式
按下 [  ] 按钮。
显示 "MUSICSEARCH" (音乐搜索)。

2 搜索音乐 
操作分类 操作

在项目之间移动 旋转控制旋钮。

项目选择 按下 [ENTER] 按钮。

返回前一个项目 按下 [ ] 按钮。

返回至首页选单 向上按下控制旋钮1秒钟以上。

取消音乐搜索模式

按下 [  ] 按钮1秒钟以上。

iPod信号源的功能

字符搜索

可以从当前选择的浏览项目列表 (艺术家、专辑等) 

中选择字符。

1 进入音乐搜索模式
按下 [  ] 按钮。
显示 "MUSICSEARCH" (音乐搜索)。

2 选择浏览项目
旋转控制旋钮选择浏览项目，然后按下 [ENTER] 

按钮。

3 进入搜索选择模式
按下 [  ] 按钮。

4 选择字符搜索模式
旋转控制旋钮选择 "Alphabet Search" (字符搜索)，

然后按下 [ENTER] 按钮。

5 选择需要搜索的字符
操作分类 操作

选择字符 旋转控制旋钮。

将光标移动到输入字符的位置 向上或者向下按下控制旋钮。

6 确定选择的字符
按下 [ENTER] 按钮。 

开始搜索。搜索结束时，在选择的字母位置再次选

择音乐搜索模式。

取消音乐搜索模式

按下 [  ] 按钮1秒钟以上。

⁄
· 根据iPod中的项目 (歌曲) 数量，字符搜索可能需要较长时

间。

· 如果搜索A至Z和1至9以外的字符，输入 "*"。

· 对于字母搜索模式，如果第一个字符串以冠词 "a" 、"an" 

或 "the" 开始，搜索将忽略该冠词。
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音乐光盘/音响文件的操作

iPod信号源/音乐编辑器媒体的功能

 跳跃搜索

跳跃的歌曲数取决于选择的列表中歌曲总数的百分

比。

1 进入音乐搜索模式
按下 [  ] 按钮。
显示 "MUSICSEARCH" (音乐搜索)。

2 进入搜索选择模式
按下 [  ] 按钮。

3 选择跳跃搜索模式
旋转控制旋钮选择 "Skip Search" (跳跃搜索)，然后

按下 [ENTER] 按钮。

4 搜索音乐 
操作分类 操作

在项目之间移动 旋转控制旋钮。

跳跃搜索 向上或者向下按下控制旋钮。

项目选择 按下 [ENTER] 按钮。

返回前一个项目 按下 [ ] 按钮。

取消音乐搜索模式

按下 [  ] 按钮1秒钟以上。

⁄
· 通过 <功能设定> (第15页) 将百分比设定为 25 跳跃搜索。

· 按住控制旋钮3秒钟以上，即按照10％跳跃歌曲，而与设

定无关。

显示 浏览项目

播放列表

艺术家

专辑

歌曲

播客

流派

作曲家

5 选择需要搜索的字符
旋转控制旋钮选择字符，然后按下 [ENTER] 按钮。

最多可选择3个字符。

6 搜索音乐
旋转控制旋钮选择 "DONE"，然后按下 [ENTER] 按

钮。

显示搜索结果列表。

7 选择音乐
旋转控制旋钮选择音乐，然后按下 [ENTER] 按钮。

取消音乐搜索模式

按下 [  ] 按钮1秒钟以上。

iPod信号源的功能

直接搜索

选择浏览项目和字符搜索音乐。

1 进入音乐搜索模式
按下 [  ] 按钮。
显示 "MUSICSEARCH" (音乐搜索)。

2 进入搜索选择模式
按下 [  ] 按钮。

3 选择直接搜索模式
旋转控制旋钮选择 "Direct Search" (直接搜索)，然

后按下 [ENTER] 按钮。

4 选择浏览项目
旋转控制旋钮选择浏览项目，然后按下 [ENTER] 

按钮。

iPod信号源的功能

关联搜索

浏览与正在播放的艺术家或流派相同的音乐。

1 进入音乐搜索模式
按下 [  ] 按钮。
显示 "MUSICSEARCH" (音乐搜索)。

2 进入搜索选择模式
按下 [  ] 按钮。

3 选择关联搜索模式
旋转控制旋钮选择 "Related Search" (关联搜索)，

然后按下 [ENTER] 按钮。

4 选择浏览项目
旋转控制旋钮，选择了需要的浏览项目后，按下 

[ENTER] 按钮。

显示 浏览音乐

"Search Artist" 显示相同艺术家的专辑。

"Search Album" 显示正在播放的音乐专辑中的音乐。

"Search Genre" 显示相同流派的艺术家。

"Search Composer" 显示由相同艺术家创作的音乐专辑。
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5 搜索音乐 
操作分类 操作

在项目之间移动 旋转控制旋钮。

项目选择 按下 [ENTER] 按钮。

返回前一个项目 向上按下控制旋钮。

取消关联搜索

按下 [  ] 按钮1秒钟以上。

⁄
· 播放播客时，无法进行关联搜索。

· 如果正在播放的音乐没有浏览项目的信息或没有搜索到音

乐，则显示 "Not Found" (没有找到)。

iPod信号源的功能

iPod的播放列表

可以登录喜爱的歌曲编制播放列表。在播放列表中最

多可登录10首歌曲。

在播放列表中登录歌曲

1 播放需要登录的歌曲
向上、向下、向右、向左按下控制旋钮。

2 登录歌曲
按下 [ENTER] 按钮2秒钟以上。

显示 "## (登录编号) Stored" (登录编号已存储)。可

最多登录10首歌曲。

⁄
· 编制播放列表时，可以登录存储在一个iPod中的歌曲。如

果试图连接未登录的iPod登录歌曲，则显示 "My Playlist 

Delete" (删除播放列表)。选择 "YES" 删除播放列表。

· 音乐搜索时显示的歌曲可按照相同的方法登录。关于音乐

搜索的步骤，请参照 <搜索iPod中的音乐> (第9页)。

· 如果试图登录第11首歌曲，则出现 "Memory Full" (存储器

存满)而无法登录。如果需要登录歌曲，请删除不需要的歌

曲。

· 请不要登录播客。否则歌曲可能不正确地登录或播放。例

如，登录不需要的歌曲。

播放播放列表

1 显示播放列表
按下 [ENTER] 按钮。

显示 "My Playlist" (播放列表)。

2 播放播放列表中的歌曲
旋转控制旋钮选择需要播放的歌曲，然后按下 

[ENTER] 按钮。

显示 "LIST" 标志。

⁄
· 如果停止播放播放列表中的歌曲，切断电源。

· 如果在一首歌曲的结束没有1秒钟或更长的无声时间，则

可能无法播放该歌曲的结束部分。

· 播放播放列表中的歌曲时，无法随机播放。

从播放列表中删除歌曲

1 显示播放列表
按下 [ENTER] 按钮。

显示 "My Playlist" (播放列表)。

2 旋转控制旋钮选择需要删除的歌曲，然后按下 
[ENTER] 按钮2秒钟以上。

3 旋转控制旋钮选择 "One" (一首) 或 "All" (全部)，
然后按下 [ENTER] 按钮。

选择 "All" (全部) 删除全部歌曲。

4 旋转控制旋钮选择 "YES" (是)，然后按下 [ENTER] 
按钮。

显示 "Completed" (完成)。

⁄
· 选择 <功能设定> (第15页) 的 26 删除播放列表，也可以删

除播放列表中的全部歌曲。
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遥控器的功能

直接搜索音乐

输入音轨号码搜索音乐。

1 进入直接搜索音乐模式
按下遥控器上的 [DIRECT] 按钮。

显示 "- -"。

2 输入音乐号码
按下遥控器上的数字按钮。

3 搜索音乐
按下遥控器上的 [4] 或 [¢] 按钮。

取消直接搜索音乐

按下遥控器上的 [  ] 按钮。

⁄
· 播放iPod时，无法使用直接音乐搜索。

带遥控器的光盘换片机的功能

光盘换片机 (选购) 的直接搜索

输入光盘或音乐的号码搜索光盘或音乐。

1 进入直接搜索模式
按下遥控器上的 [DIRECT] 按钮。

显示 "- -"。

2 输入光盘或音乐号码
按下遥控器上的数字按钮。

3 搜索光盘
按下遥控器上的 [FM] 或 [AM] 按钮。

 搜索音乐

按下遥控器上的 [4] 或 [¢] 按钮。

取消直接搜索

按下遥控器上的 [  ] 按钮。

⁄
· 选择光盘10时输入 "0"。

音乐光盘/音响文件的操作

光盘换片机的功能

光盘换片机 (选购) 的基本操作

选择CD换片机信号源

按下 [SRC] 按钮。

选择 "CD CH" 显示。

关于信号源项目的选择方法，请参照 <电源和选择

信号源> (第5页)。

音乐搜索

向后或向左按下控制旋钮。

光盘搜索

向上或者向下按下控制旋钮。
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调谐器的操作方法

电台预设存储

向存储器输入电台。

1 选择存储的频率
向左或向右按下控制旋钮。

2 进入预设存储模式
按下 [  ] 按钮。

3 预设电台
旋转控制旋钮选择预设号码 ("P1" - "P6")，然后按

下 [ENTER] 按钮2秒钟以上。

取消预设存储模式

按下 [  ] 按钮。

预设调谐

呼出存储器中的电台。

1 进入预设调谐模式
按下 [  ] 按钮。

2 呼出电台
旋转控制旋钮选择呼出号码 ("P1" - "P6")，然后按

下 [ENTER]。

取消预设调谐

按下 [  ] 按钮。

遥控器的功能

直接调谐

输入频率进行调谐。

1 进入直接调谐模式
按下遥控器上的 [DIRECT] 按钮。

显示 "- - - -"。

2 输入频率
按下遥控器上的数字按钮。

例:

所需频率 按键

92.1 MHz (FM) [9], [2], [1]

810 kHz (AM) [8], [1], [0]

3 搜索频率
按下遥控器上的 [4] 或 [¢] 按钮。

取消直接搜索音乐

按下遥控器上的 [  ] 按钮。

⁄
· 可以输入的FM波段频率的最小单位是0.1MHz。

设定频率步进

改变调谐频率步进。

FM波段的初始设定为50kHz，AM波段为9kHz。

1 切断电源
按下 [SRC] 按钮1秒钟以上。

2 切换频率步进
在按下 [FAVORITE] 按钮和 [ENTER] 按钮的同时按

下 [SRC] 按钮。

出现显示后松开按钮。

FM波段的频率步进变更成为200kHz，AM波段变更

成为10kHz。

⁄
· 重复相同的操作时，频率步进恢复到初始设定。

· 变更频率步进后，存储的频率被删除。
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常用控制

常用预设呼出

呼出在常用存储中登录的项目。

1 进入常用预设呼出模式
按下 [FAVORITE] 按钮。

2 选择从常用存储中呼出的号码
旋转控制旋钮。

3 呼出常用预设
按下 [ENTER] 按钮。

取消常用预设呼出模式

按下 [  ] 按钮。

常用预设存储

可以登录广播电台、iPod播放列表或艺术家、功能设

定项目或音响控制项目等常用项目。

1 显示需要登录的项目
可登录的项目如下所示:

信号源 可登录项目

调谐器 频率

iPod 播放列表/艺术家/专辑等浏览项目

功能设定 功能设定项目

音响控制* 音响控制项目

显示控制* 显示控制项目

免提手机 电话号码呼出。

*  KDC-U6046/ KDC-U6046L的功能

(KDC-U7046BT/ KDC-U7046BTL，音响控制项目和显示

控制项目包含在功能设定。)

选择可登录项目时，" FAV  " 指示点亮5秒钟。

进入步骤2，过后再回到点亮 " FAV  " 的项目。

如果各项目的设定操作可以通过功能设定完

成，" FAV  " 标志消失，无法向常用控制登录。

2 进入常用预设存储模式
按下 [FAVORITE] 按钮1秒钟以上。

3 选择存储的号码
旋转控制旋钮。

4 存储常用预设
按下 [ENTER] 按钮。

取消常用预设存储模式

按下 [  ] 按钮。

⁄
· 可登录6对常用预设存储。

对可预设的号码显示 "Register your favorite functions" (登

录常用功能)。

· 存储内容不会被复位按钮清除。

· 向现存的预设号码登录操作步骤将重写现存的操作步骤。

· 选择 <功能设定> (第15页) 的 36 常用删除，可以删除登录

的项目。

· 如果第二阶层或更低阶层的项目改变，常用登录后，iPod

中的列表将因添加或删除歌曲而改变。因此，在本机登录

的列表将与iPod中的列表有所不同。编辑了iPod中的项目

后，应重新进行常用登录。

· 使用本功能时，本机必须接通电源1小时以上。

 取消常用预设存储

删除向常用存储登录的项目。

1 选择待机
按下 [SRC] 按钮。

选择 "STANDBY" 显示。

关于信号源项目的选择方法，请参照 <电源和选择

信号源> (第5页)。

2 进入功能设定模式
按下 [FNC] 按钮。

3 选择常用删除模式
可选择和确定以下项目。

"Initial Settings" ➜ "Favorite Delete"

选择项目时，旋转控制旋钮。确定项目时，按下 

[ENTER] 按钮。

4 选择需要删除的号码
旋转控制旋钮选择存储号码，然后按下 [ENTER] 

按钮。

显示 "Favorite Delete" (常用删除)。

如果需要全部删除，请选择 "All" (全部)。

5 旋转控制旋钮选择 "YES" (是)，然后按下 [ENTER] 
按钮。

显示 "Completed" (完成)。

6 退出功能设定模式
按下 [  ] 按钮1秒钟以上。
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 功能设定

通过以下步骤配置本机功能: 

1 搜索需要设定的项目
按照 <功能项目> (第15页) 选择设定项目。

2 选择信号源
按下 [SRC] 按钮。

按照 <功能表> (第19页) 将信号源切换到显示设定

项目。

关于信号源项目的选择方法，请参照 <电源和选择

信号源> (第5页)。

3 进入功能设定模式
按下 [FNC] 按钮。

4 选择功能项目
旋转控制旋钮选择需要设定的项目。

5 进入选择的功能项目
按下 [ENTER] 按钮。

按下 [  ] 按钮返回至前一个项目。 

重复操作步骤4和步骤5，直到获得需要设定的项

目。

6 设定功能项目
旋转控制旋钮选择需要的设定值。

7 确定设定值
按下 [ENTER] 按钮。

显示前一个项目。

8 退出功能设定模式
按下 [  ] 按钮1秒钟以上。

 功能项目

例:

 No.  功能名称: "显示本机的各项功能" ➤ "设定值1"*, 

"设定值2"...

提供功能项目概观。显示本功能的信号源可以按照

<功能表> (第19页) 中的号码 (0 0) 找到。

⁄
· 划下线的设定值为出厂设定。

音乐播放模式

 01  手动控制iPod: "Hands Mode" ➤ "ON", "OFF" 

当设定为 "ON" 时，可以使用iPod的控制功能操作

iPod。

 02  扫描播放: "Track Scan" (CD)/ "File Scan" (音响文

件) ➤ "ON", "OFF" 

当设定为 "ON" 时，连续播放光盘/文件夹内音乐

的开头。

 03  随机播放: "Disc Random" (CD)/ "Folder Random" 

(音响文件/iPod) ➤ "ON", "OFF" 

当设定为 "ON" 时，随机播放光盘/文件夹内的音

乐。

 04  全部随机播放: "All Random(iPod) ➤ "ON", "OFF" 

当设定为 "ON" 时，随机播放iPod中的全部歌曲。

 05  音轨/文件重复播放: "Track Repeat" (CD)/ "File 

Repeat" (音响文件/iPod) ➤ "ON", "OFF" 

当设定为 "ON" 时，重复播放音乐。

 06  光盘/文件夹重复播放: "Disc Repeat" (CD换片机)/ 

"Folder Repeat" (音响文件) ➤ "ON", "OFF" 

当设定为 "ON" 时，重复播放光盘/文件夹内的音

乐。

 07  换片机随机播放: "MGZN Random" (光盘换片机) 

➤ "ON", "OFF" 

当设定为 "ON" 时，随机播放光盘换片机中的音

乐。

显示控制

 08  选择显示类型: "Display Control" ➤ 5种类型

设定显示类型。

显示类型 显示信息

A型 显示2行文本。

B型 显示1行文本。

C型 显示状态。

D型 显示时钟。

E型 显示频谱分析仪。

请参照 <选择显示类型> (第20页)。

 09  显示侧面选择: "DISP Side Select" ➤ 2种类型

设定类型A、B、D和E侧面显示接通/切断。

请参照 <选择显示类型> (第20页)。

 10  显示文本选择: "DISP Text Select"

设定A型和B型文本显示。

请参照 <选择文本显示> (第20页)。

 11  显示图形选择: "DISP GRPHC Select" ➤ 6种类型

设定E型频谱分析仪显示。

请参照 <选择显示类型> (第20页)。
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时钟和日期设定

 12  调节时钟: "Clock Adjust" 

设定时钟。请参照 <调节时钟和日期> (第4页)。

 13   调节日期: "Date Adjust" 

设定日期。请参照 <调节时钟和日期> (第4页)。

 14  选择日期模式: "Date Mode" ➤ 7种类型

设定日期显示模式。

请参照 <调节时钟和日期> (第4页)。

显示和照明设定

 15  显示接通/切断: "DISP OFF Mode" ➤ "ON", "OFF" 

如果选择了 "ON"，当不操作本机的时间超过5秒

钟，显示关闭。在设定模式时，即使经过了5秒钟也

不关闭显示。

 16  显示调光器: "Display Dimmer" ➤ "Auto" (自动), 

"Manual1" (手动1), "Manual2" (手动2), "OFF" 

与车灯开关联动，降低显示屏亮度。

 17  文本滚动: "Text Scroll" ➤ "Auto" (自动), "Manual" 

(手动)

设定 "Auto" (自动) 时，自动滚动显示的文本。

 18    显示Bluetooth装置状态: "BT DVC Status" 

可以显示连接状态、信号强度和电池电量。

 :  手机电池电量。

 :  手机信号强度。

KDC-U7046BT/ KDC-U7046BTL/ KCA-BT200 (选

购附件) 的功能。

 19  照明调光器: "ILLUMI Dimmer" ➤ "Auto" (自动), 

"Manual1" (手动1), "Manual2" (手动2), "OFF" 

降低按键照明亮度。

Auto:  照明与车灯开关联动变暗。

Manual1:  照明始终变暗。

Manual2:  照明比手动1更暗。

OFF:  照明不变暗。

 20  照明效果: "ILLUMI Effect" ➤ "ON", "OFF" 

设定按键照明色彩是否与按键操作联动变化。

 21   音乐链接照明效果: "ILLUMI Music SYNC" ➤ 

"ON", "OFF" 

设定按键照明色彩是否与音量联动变化。

调谐器设定

 22  搜索模式: "Seek Mode" ➤ "Auto1" (自动1), 

"Auto2" (自动2), " Manual" (手动)

选择接收装置的调谐模式。

调谐模式 显示 操作

自动搜索 "Auto1" 自动搜索电台。

预设电台搜索 "Auto2" 按照预设存储中的电台顺
序搜索。

手动 "Manual" 通常的手动调谐控制。

 23  自动存储: "Auto Memory"

自动存储6个接收状态良好的电台。

旋转控制旋钮选择 "YES" (是)，然后按下[ENTER]按

钮开始自动存储操作。

 24  单声道接收: "MONO" ➤ "ON", "OFF" 

当立体声广播作为单声道接收时，可以减少噪音。

iPod设定

 25  跳跃搜索: "Skip Search" ➤ "0.5%", "1%", "5%", 

"10%" 

通过 <跳跃搜索> (第10页) 设定跳跃百分比。

 26  删除播放列表: "My Playlist Delete"

删除播放列表中登录的歌曲。

旋转控制旋钮选择 "YES"，然后按下 [ENTER] 按钮

删除播放列表。

辅助设定

 27  名称设定: "Name SET" ➤ "AUX", "DVD", 

"PORTABLE", "GAME", "VIDEO", "TV" 

设定切换至AUX信号源时的显示。

音响设定

 28  音响控制: "Audio Control" 

设定音质和扬声器系统。

请参照 <音响控制> (第7页)。

KDC-U7046BT/ KDC-U7046BTL的功能。

 功能设定
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初始设定

 29  信号源选择模式: "SRC Select" ➤ "1", "2" 

设定信号源选择方法。

 30  提示音: "Key Beep" ➤ "ON", "OFF" 

设定操作核对音 (提示音) 的接通/切断。

 31  忘记拆除面板提示音: "TDF Alarm" ➤ "ON", "OFF" 

如果关闭汽车发动机钥匙后没有拆除面板，将发出

30秒提示音。

 32  中文语言设定: "Chinese" ➤ "ON", "OFF" 

设定为接通时，以中文显示下列字符串:  

文件夹名称/文件名称/歌曲标题/艺术家姓名/专辑名

称/KCA-BT200 (选购附件)

KDC-U7046BT/ KDC-U6046的功能。

 33  语言设定: "Language Select" ➤ "English" (英语), 

"Arabic" (阿拉伯语) ,"Persian" (波斯语), "Thai" (

泰语)

设定为 "Arabic" (阿拉伯语)、"Persian" (波斯语) 

"Thai" (泰语)时，下列字符串将以阿拉伯语、波斯语

或泰语显示: 

文件夹名称/文件名称/歌曲标题/艺术家姓名/专辑名

称/KCA-BT200 (选购附件)。

KDC-U7046BTL/ KDC-U6046L的功能。

 34  内置AUX: "Built-in AUX" ➤ "ON", "OFF" 

设定在选择信号源时是否显示AUX。

 35  CD 读取: "CD Read" ➤ "1", " 2" 

设定读取CD的方法。

当无法播放某一特殊格式的CD时，将该功能设定为 

"2" 进行强制播放。请注意，即使设定为 "2" 也可能

无法播放某些音乐CD。

此外，当设定为 "2" 时，无法播放音响文件。在通常

情况下，请设定为 "1"。

1 :  在播放光盘时，自动识别音响文件光盘和音乐

CD。

2 : 作为音乐CD进行强制播放。

 36  常用删除: "Favorite Delete" ➤ 预设号码, "All" 

(全部)

删除常用预设存储。

请参照 <取消常用预设存储> (第14页)。

 37  内置放大器设定: "Built-in AMP" ➤ "ON", "OFF" 

选择 "OFF" 关闭内置放大器。切断内置放大器，改

善预输出的音质。

 38  扬声器选择: "Speaker Select" ➤ "OFF", "5/4inch" 

(5/4英寸), "6x9/6inch" (6×9/6英寸), "O.E.M" 

微调实现系统Q的最佳值按照以下设定扬声器类

型时;

扬声器类型 显示

关闭 "OFF" 

对于5英寸和4英寸扬声器 "5/4inch" 

对于6英寸和6×9英寸扬声器 "6x9/6inch" 

对于OEM扬声器 "O.E.M" 

 39  固件升级: "F/W Update #.##" ➤ "USB", "CD" 

升级固件。

选择 "YES" (是)，然后按下 [ENTER] 按钮开始升

级固件。

关于固件的升级方法，请浏览本公司网站。

http://www.kenwood.com/cs/ce/

演示模式设定

 40  演示模式: "DEMO Mode" ➤ "ON", "OFF" 

设定是否启动演示。

KDC-U7046BT/ KDC-U7046BTL/ KCA-BT200 (选购附
件) 的功能

Bluetooth设定

 41  手机选择: "Phone Selection" 

根据免提连接选择手机。

请参照 <选择需要连接的Bluetooth装置> (第28页)。

 42  音响选择: "Audio Selection" 

选择需要连接的 Bluetooth音响播放器。

请参照 <选择需要连接的Bluetooth装置> (第28页)。

 43  短信下载: "SMS Download" 

下载短信。请参照<下载短信> (第31页)。

 44  短信收件箱显示: "SMS Inbox" 

显示接收的短信。请参照 <显示SMS> (第31页)。

KCA-BT200 (选购附件) 的功能。

 45  添加语音指令: "PN Type Edit" 

对语音识别登录语音。

请参照 <添加语音拨号指令> (第29页)。

KCA-BT200 (选购附件) 的功能。

 46  语音指令分类设定: "PB Type Edit" 

登录用于选择电话簿中电话号码分类的语音。

请参照 <对分类设定语音指令> (第30页)。

KCA-BT200 (选购附件) 的功能。

 47  登录装置: "Device Regist." 

登录Bluetooth装置 (配对)。

请参照 <登录Bluetooth装置> (第26页)。
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 功能设定

 48  登录特殊装置: "SPCL DVC Select" 

允许登录无法正常登录的特殊装置。

请参照 <登录特殊Bluetooth装置> (第26页)。

 49  删除装置: "Device Delete" 

取消Bluetooth装置的登录。

请参照 <删除登录的Bluetooth装置> (第28页)。

 50  PIN代码编辑: "PIN Code Edit" 

设定当使用Bluetooth装置登录本机时需要的PIN代

码。请参照 <登录PIN代码> (第27页)。

 51  设定自动应答的时间间隔: "Auto Answer" ➤ 

"OFF", "0SEC" - "8SEC" - "99SEC" 

本功能在预先设定的时间经过后自动接听来电。

 "OFF" :  不自动接听电话。

 "0" :  立即自动接听电话。

 "1s" - "99s" :  经过1-99秒后自动接听来电。

 52  扬声器选择: "Bluetooth HF/Audio" ➤ "Front" (前

侧), "All" (全部)

可以指定免提通话和Bluetooth音响的输出扬声器。

"Front" :  从前侧扬声器输出。

"All" :  从前侧和后侧扬声器输出。

 53  设定来电提示音: "Call Beep" ➤ "ON", "OFF" 

当有来电时可输出哔哔声。

 "ON" :  发出哔哔声。

 "OFF" :  取消哔哔声。

 54  Bluetooth固件升级: "BT F/W Update" 

显示固件版本和升级固件。

请参照 <显示固件版本> (第29页)。

 55  麦克风增益: "MIC Gain" ➤ "-3" - "0" - "+3" 

调节内设麦克风的灵敏度用于通话。调节通话人的

声音。设定为 "+" 提高音量。

KDC-U7046BT/ KDC-U7046BTL的功能。

 56  降低噪音: "NR Level" ➤ "-3" - "0" - "+3" 

 降低由周围环境产生的噪音，无需变更内设麦克风

音量。语音不清晰时请调节通话人的声音。设定为 

"+" 提高降低噪音的强度。

KDC-U7046BT/ KDC-U7046BTL的功能。

 57  取消回音等级: "Echo Cancel" ➤ "-2" - "0" - "+2" 

设定取消回音等级。

KDC-U7046BT/ KDC-U7046BTL的功能。

 58  麦克风设定: "MIC Select" ➤ "Builtin" (内置), 

"External" (外接)

接收机内设麦克风时，确定使用内置或外接麦克

风。

Builtin: 使用内置麦克风。

External: 使用外接麦克风。

KDC-U7046BT/ KDC-U7046BTL的功能。

⁄
· 如果在Bluetooth模式下没有选择功能设定模式，可以设定

Bluetooth功能设定项目。

1. 按下 [  ] 按钮( KDC-U7046BT   KDC-U7046BTL )/ 

[FNC] 按钮 ( KDC-U6046   KDC-U6046L ) 1秒钟以上进入

Bluetooth模式。

2. 旋转控制旋钮选择 "BT Setting"，然后按下 [ENTER] 按

钮。

3. 旋转控制旋钮选择需要的项目，然后按下 [ENTER] 按

钮。

4. 旋转控制旋钮选择数值，然后按下 [ENTER] 按钮。

10Entry_stepup_M_CHS.indd   1810Entry_stepup_M_CHS.indd   18 10/01/08   11:0510/01/08   11:05



中文   |   19

 功能表

选择信号源时出现的功能项目

功能项目列表 No.
"Settings"  "Clock & Date"  "Clock Adjust" 12

 "Date Adjust" 13

 "Date Mode" 14

"DISP & ILLUMI"  "DISP OFF Mode" 15

 "Display Dimmer" 16

 "Text Scroll" 17

 "BT DVC Status" 18

 "ILLUMI Dimmer" 19

 "ILLUMI Effect" 20

 "ILLUMI Music 
SYNC"

21

 "Display 
Control"

 ("DISP SELECT") 08

 "DISP Side Select" 09

 "DISP Text Select" 10

 "DISP GRPHC 
Select"

11

 "DEMO Mode" 40

待机时出现的功能项目

功能项目列表 No.
 "Initial 
Settings"

 "SRC Select" 29

 "Key Beep" 30

 "TDF Alarm" 31

 "Chinese" 32

 "Language Select" 33

 "Built-in AUX" 34

 "CD Read" 35

 "Favorite Delete" 36

 "Built-in AMP" 37

 "Speaker Select" 38

 "F/W Update #.##" 39

播放CD、音响文件、或iPod时出现的功能项目

功能项目列表 No.
 "Audio Control" 28

"Play Mode"  "Hands Mode" (iPod) 01

 "Track Scan"(CD)/"File Scan"(音响文件) 02

 "Disc Random"(CD)/"Folder Random"(音
响文件/iPod)

03

 "All Random"(iPod) 04

 "Track Repeat"(CD)/"File Repeat"(音响
文件/iPod)

05

 "Disc Repeat"(CD换片机)/"Folder 
Repeat"(音响文件)

06

 "MGZN Random"(光盘换片机) 07

"Settings"  "Skip Search"(iPod/音乐编辑器媒体) 25

 "My Playlist Delete"(iPod) 26

选择调谐器信号源时出现的功能项目

功能项目列表 No.
 "Audio Control" 28

"Settings"  "Seek Mode" 22

 "Auto Memory" 23

 "MONO" 24

选择AUX信号源时出现的功能项目

功能项目列表 No.
"Audio Control" 28

"Settings"  "Name SET" 27

Bluetooth模式时出现的功能项目

功能项目列表 No.
"Settings"  "Phone Selection" 41

 "Audio Selection" 42

 "SMS Download" 43

 "SMS Inbox" 44

 "Voice Tag"  "PN Type Edit" 45

 "Detailed Settings" 46

 "Detailed Settings"  "Device Regist." 47

 "SPCL DVC Select" 48

 "Device Delete" 49

 "PIN Code Edit" 50

 "Auto Answer" 51

 "Bluetooth HF/
Audio"

52

 "Call Beep" 53

 "BT F/W Update" 54

 "MIC Gain" 55

 "NR Level" 56

 "Echo Cancel" 57

 "MIC Select" 58
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显示设定

 选择显示类型

显示类型例如下所示。

显示名称 显示类型

A型 显示2行文本。

B型 显示1行文本。

C型 显示状态(各功能的接通/切断指示)。

D型 显示时钟。

E型 显示频谱分析仪。

1进入显示控制模式
 KDC-U6046   KDC-U6046L 

按下 [DISP] 按钮。

 KDC-U7046BT   KDC-U7046BTL 

1)  按下 [FNC] 按钮。

2)  旋转控制旋钮选择 "Display Control"，然后按下 

[ENTER] 按钮。

2 选择选择显示类型模式
旋转控制旋钮选择显示类型，然后按下 [ENTER] 

按钮。

3 选择显示类型
旋转控制旋钮选择显示信息项目，然后按下 

[ENTER] 按钮。

可设定以下显示信息项目:

· 侧面显示选择(选择显示类型A、B、D或E时)

选择 "DISP Side Select"。

请参照 <功能设定> (第15页) 的 09 显示侧面选

择。

· 文本显示选择 (选择显示类型A或B时)

选择 "DISP Text Select"。

请参照 <选择文本显示> (第20页)。

· 图形选择 (选择显示类型E时)。

选择 "DISP GRPHC Select" 显示。

请参照 <功能设定> (第15页) 的 11 显示图形选

择。

4 退出功能设定模式
按下 [  ] 按钮1秒钟以上。

 选择文本显示

对下列各信号源变更显示的信息:

调谐器信号源

信息 显示

频率 "Frequency" 

频谱分析仪和时钟 "Speana/Clock" 

日期 "Date" 

显示状态 (仅限A型显示) "Indicator" 

空白 "Blank" 

CD和外部光盘信号源

信息 显示

光盘标题 "Disc Title" 

音轨标题 "Track Title" 

播放时间 "P-Time" 

频谱分析仪和时钟 "Speana/Clock" 

日期 "Date" 

显示状态 (仅限A型显示) "Indicator" 

空白 "Blank" 

音响文件/iPod信号源

信息 显示

标题和艺术家姓名 "Title/Artist" 

专辑和艺术家姓名 "Album/Artist" 

文件夹名称 "Folder Name" 

文件名称 "File Name" 

播放时间 "P-Time" 

频谱分析仪和时钟 "Speana/Clock" 

日期 "Date" 

显示状态 (仅限A型显示) "Indicator" 

空白 "Blank" 

待机/辅助输入信号源

信息 显示

信号源名称 "Source Name" 

频谱分析仪和时钟 (仅限AUX) "Speana/Clock" 

时钟 (仅限待机) "Clock" 

日期 "Date" 

显示状态 (仅限A型显示) "Indicator" 

空白 "Blank" 
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Bluetooth音响 "BT Audio" (KDC-U7046BT/ 

KDC-U7046BTL)/ "BT Audio EXT" (KCA-BT200; 选购附

件) 信号源

信息 显示

信号源名称 "Source Name" 

标题和艺术家姓名 
(仅限KDC-U7046BT/KDC-U7046BTL)

"Title/Artist" 

专辑和艺术家姓名
(仅限KDC-U7046BT/KDC-U7046BTL)

"Album/Artist" 

频谱分析仪和时钟 "Speana/Clock" 

日期 "Date" 

显示状态 (仅限A型显示) "Indicator" 

空白 "Blank" 

1 进入显示控制模式
 KDC-U6046   KDC-U6046L 

按下 [DISP] 按钮。

 KDC-U7046BT   KDC-U7046BTL 

1)  按下 [FNC] 按钮。

2)  旋转控制旋钮选择 "Display Control"，然后按下 

[ENTER] 按钮。

2 选择显示类型
旋转控制旋钮选择显示类型A或B，然后按下 

[ENTER] 按钮

3 选择文本显示选择模式
旋转控制旋钮选择 "DISP Text Select"，然后按下

[ENTER]按钮。

4 选择文本显示部分 (仅限显示类型A)
向上或者向下按下控制旋钮。

选择的文本显示 部分闪烁。

5 选择文本
旋转控制旋钮。

6 退出功能设定模式
按下 [  ] 按钮1秒钟以上。

⁄
· 如果选择的显示项目没有信息，则显示其他信息。

· 根据显示类型和行，某些项目无法选择。

· 在播放iPod时，如果选择 "Folder name" (文件夹名称)，将

根据当前选择的浏览项目显示名称。

· 播放iPod时，如果手动控制iPod模式设定接通，则显示 

"iPod By Hand Mode" (手动控制iPod模式)。

· 使用iPod播放时，如果所有字符无法显示，将显示列表中

的文件号码。

信息 显示

音乐名称 "TITLE***" 

文件夹名称 "FLD***" 

文件名称 "FILE***" 
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免提通话的操作
KDC-U7046BT/ KDC-U7046BTL/ KCA-BT200 (选购附件) 的功能

使用之前

· 有关Bluetooth手机免提功能的详细内容，请参照 
<关于手机> (第34页)。

· 在使用本产品之前，需要先登录你的手机。有关详
细内容，请参照 <登录Bluetooth装置> (第26页)。

· 如果你已经登录了两部或更多部手机，则需要从中
选择需要使用的一部。有关详细内容，请参照 <选
择需要连接的Bluetooth装置> (第28页)。

· 使用电话簿之前，必须先下载到本机。有关详细内
容，请参照 <下载电话簿> (第27页)。

接听电话

接听电话

 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [ENTER] 按钮。

⁄
· 以下操作将挂断电话:

- 插入CD。

- 连接USB装置。

· 如果已经在电话簿中登录，将显示通话对方的姓名。

拒接来电

 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [SRC] 按钮。

 拨打电话簿中的号码

1 进入Bluetooth模式
 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [FNC] 按钮1秒钟以上。

显示 "BT MODE" (Bluetooth模式)。

2 选择姓名搜索模式
旋转控制旋钮选择 "Name Search" (姓名搜索)，然

后按下 [ENTER] 按钮。

3 输入姓名首字母
操作分类 操作

选择字符。 旋转控制旋钮。

翻动字符页。 向上或者向下按下控制旋钮。

拨打号码

1 进入Bluetooth模式
 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [FNC] 按钮1秒钟以上。

显示 "BT MODE" (Bluetooth模式)。

2 选择拨号模式
旋转控制旋钮选择 "Number Dial" (拨号)，然后按

下 [ENTER] 按钮。

3 输入电话号码
旋转控制旋钮选择号码，然后向右按下控制旋钮。

4 通话
 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [ENTER] 按钮。

逐位删除输入的电话号码: 

向左按下控制旋钮。

⁄
· 最多可输入32位。

4 搜索姓名
按下 [ENTER] 按钮。

5 选择电话号码
旋转控制旋钮。

向右或向左按下控制旋钮，按照姓名排序电话簿。

6 通话
 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [ENTER] 按钮。

⁄
· 每次按下 [ENTER] 按钮时，显示按照姓名、电话号码、时

间标记的顺序变化。( KDC-U7046BT   KDC-U7046BTL )

· 在搜索中，对于诸如 "u" 的重音字符，按照 "ü" 等无重音

字符搜索。
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拨打通话记录中的号码

1 进入Bluetooth模式
 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [FNC] 按钮1秒钟以上。

显示 "BT MODE" (Bluetooth模式)。

2 选择通话记录模式
旋转控制旋钮选择 "Incoming Calls" (来电通话)、 

"Outgoing Calls" (拨出通话)、或者 "Missed Calls" 

(未接听通话)，然后按下 [ENTER] 按钮。

 "Incoming Calls" : 来电通话

 "Outgoing Calls" : 拨出通话

 "Missed Calls" : 未接听通话

3 选择姓名或电话号码
旋转控制旋钮。

4 通话
 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [ENTER] 按钮。

⁄
· 每次按下 [ENTER] 按钮时，显示按照姓名、电话号码、时

间标记的顺序变化。( KDC-U7046BT   KDC-U7046BTL )

· 拨出通话列表、来电通话列表及未接通话列表是由本机拨

出和接收的电话列表，并不是存储在手机内的列表。

快速拨号 (预设拨号)

1 进入Bluetooth模式
 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [FNC] 按钮1秒钟以上。

显示 "BT MODE" (Bluetooth模式)。

2 选择需要从存储器中呼出的号码
旋转控制旋钮选择呼出号码 ("P1" - "P6")，然后按

下 [ENTER] 按钮。

3 通话
 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [ENTER] 按钮。

⁄
· 需要登录预设拨号号码。

 请参照 <预设拨号号码列表的登录> (第23页)。

 预设拨号号码列表的登录

1 输入需要登录的电话号码
参照以下内容输入电话号码:

拨打号码/拨打通话记录中的号码/拨打电话簿中

的号码

2 进入预设存储模式
按下 [  ] 按钮。

3 选择号码进行存储
旋转控制旋钮选择存储号码 ("P1" - "P6")，然后按

下 [ENTER] 按钮2秒钟以上。

取消预设存储模式

按下 [  ] 按钮。

在通话中

中断通话

按下 [SRC] 按钮。

切换到专用模式

向右或向左按下控制旋钮。

每次按下该按钮，即在专用通话 ("PRIVATE" (专用)) 

和免提通话之间切换。

⁄
· 某些型号的手机在切换到专用通话模式时可能选择在开始

免提通话之前使用的装置。如果发生这种情况，操作本机

无法将信号源切换回免提通话模式。请操作手机恢复到免

提通话模式。

在通话时调整音量

旋转控制旋钮。
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免提通话的操作
KDC-U7046BT/ KDC-U7046BTL/ KCA-BT200 (选购附件) 的功能

通话等候

暂停当前的通话，接听其他来电

 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

1)  按下 [FNC] 按钮1秒钟以上。

2)  旋转控制旋钮选择 "Answer" (接听)，然后按下 

[ENTER] 按钮。

中断当前的通话，接听其他来电

按下 [SRC] 按钮。

继续当前的通话

 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

1)  按下 [ENTER] 按钮。

2)  旋转控制旋钮选择 "Reject" (拒接)，然后按下 

[ENTER] 按钮。

中断当前的通话，接听等候的通话

按下 [SRC] 按钮。

在当前的通话和等候的通话之间切换

 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [ENTER] 按钮。

每次按下该旋钮，切换通话的对方。

KCA-BT200 (选购附件) 的功能

进行语音拨号通话

1 进入Bluetooth模式
按下 [FNC] 按钮1秒钟以上。

显示 "BT MODE" (Bluetooth模式)。

2 进入语音识别模式
按下 [AUDIO] 按钮1秒钟以上。

3 本机识别说出的姓名
按下 [ENTER] 按钮。 听到提示音后，请在2秒钟

内说出登录的姓名。

4 本机识别说出的分类
听到提示音后，请在2秒钟内说出分类。

显示识别的电话号码 (姓名)。

如果需要改变显示的电话号码 (姓名)，按下 [DISP] 

按钮。

5 通话
按下 [ENTER] 按钮。

⁄
· 如果语音没有被识别，则显示消息。

 请参照 <故障检修> (第36页)。

按下 [ENTER] 按钮，可以重新进行语音输入。

· 姓名和分类都需要进行语音标签的登录。请参照 <对分类

设定语音指令> (第30页)。

清除中断连接的消息

 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下[FNC]按钮1秒钟以上。

 "HF Disconnect" (免提未连接) 消失。

显示电话号码类型 (分类)

按照以下显示电话簿中的分类项目:

显示 信息

"General" / " " 共同

"Home" / " " 自家

"Office" / " " 办公室

"Mobile" / " " 手机

"Other" / " " 其他
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KDC-U7046BT/ KDC-U7046BTL/ KCA-BT200 (选购附件) 的功能

Bluetooth音响装置的操作方法

使用之前

· 有关可连接的Bluetooth音响播放器的详细内容，请
参照 <关于Bluetooth音响播放器> (第34页)。

· 在连接本机使用之前，需要登录Bluetooth音响播放
器。有关详细内容，请参照 <登录Bluetooth装置> 
(第25页)。

· 需要选择希望连接的Bluetooth音响播放器。请参照
<选择需要连接的Bluetooth装置> (第28页)。

基本操作方法

选择Bluetooth音响信号源

按下 [SRC] 按钮。

选择 "BT AUDIO" (Bluetooth音响) 

( KDC-U7046BT   KDC-U7046BTL )/ "BT AUDIO EXT" 

(Bluetooth音响输出) ( KDC-U6046   KDC-U6046L ) 显

示。

关于信号源项目的选择方法，请参照 <电源和选择

信号源> (第5页)。

暂停和播放

按下 [  ] 按钮。

音乐搜索

向右或向左按下控制旋钮。

⁄
· 如果Bluetooth音响播放器的遥控准备未就绪，上述操作的

全部或者一部分无法进行。

· Bluetooth音响信号源之间的切换不会自动开始或停止播

放。请完成开始或停止播放的操作。

· 分离Bluetooth连接后，某些音响播放器无法遥控操作或者

重新连接。操作音响播放器的主机连接Bluetooth装置。

· 如果 <音响控制> (第7页) 的 "2Zone" (双区域系统) 设定为 

"ON"、并且 "2Zone F/R Select" (双区域系统前/后侧选择) 

设定为 "Front" (前侧)，则无法选择Bluetooth音响信号源。
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Bluetooth设置
KDC-U7046BT/ KDC-U7046BTL/ KCA-BT200 (选购附件) 的功能

 登录Bluetooth装置

为了本机能够使用您的Bluetooth装置 (手机)，需要

进行登录 (配对)。对本机最多可以登录5台Bluetooth

装置。

当通过Bluetooth装置登录时

1 接通本机电源。
2 操作Bluetooth装置向本机登录
操作Bluetooth装置，向免提装置登录 (配对)。在连

接的装置列表中，选择 "KENWOOD BT CD/R-4P1" 

或 "KCA-BT200"。

3 输入PIN代码
输入按照 <登录PIN代码> (第27页) 说明登录的PIN

代码。

确认Bluetooth装置的登录是否完成。

4 操作Bluetooth装置，开始免提连接。
通过本机登录时

1 进入Bluetooth模式
 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下[FNC]按钮1秒钟以上。

显示 "BT MODE" (Bluetooth模式)。

2 进入功能设定模式
按下 [FNC] 按钮。

3 选择Bluetooth装置登录模式
可选择和确定以下项目。

"Settings" (设定) ➜ "Detailed Settings" ➜

"Device Regist." 

选择项目时，旋转控制旋钮。确定项目时，按下 

[ENTER] 按钮。

搜索Bluetooth装置。

搜索完成后，显示 "Finished" (完成)。

4 选择Bluetooth装置
旋转控制旋钮选择需要的Bluetooth装置，然后按下 

[ENTER] 按钮。

 KDC-U7046BT   KDC-U7046BTL 

如果显示 "Paring Success" (配对成功)，则无需输

入PIN代码 (步骤5和6)。如果显示 "Pin Code NG" 

(PIN代码不正确)，按下 [ENTER] 按钮。然后输入

PIN代码 (步骤5和6)。

 KDC-U6046   KDC-U6046L 

输入PIN代码 (步骤5和6)。

5 输入PIN代码
操作分类 操作

选择号码。 旋转控制旋钮。

移动到下一位。 向右按下控制旋钮。

删除最后一位。 向左按下控制旋钮。

6 传送PIN代码
按下 [ENTER] 按钮。

如果显示 "Pairing Success" (配对成功)，则登录

完成。

7 返回至装置列表
按下 [ENTER] 按钮。

8 退出Bluetooth模式
按下 [SRC] 按钮。

⁄
· 本机最多可以输入八位数字作为PIN代码。如果PIN代码无

法通过本机输入，则可以通过Bluetooth装置输入。

· 如果已经登录了5台或更多的Bluetooth装置，则无法登录新

的Bluetooth装置。

· 如果即使PIN代码正确但仍然出现错误消息，请尝试 <登录

特殊Bluetooth装置> (第26页)。

 登录特殊Bluetooth装置

允许登录无法正常登录 (配对) 的特殊装置。

1 进入Bluetooth模式
 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [FNC] 按钮1秒钟以上。

显示 "BT MODE" (Bluetooth模式)。

2 进入功能设定模式
按下 [FNC] 按钮。

3 选择特殊装置登录模式
可选择和确定以下项目。

"Settings" (设定) ➜ "Detailed Settings" ➜

"SPCL DVC Select" 

选择项目时，旋转控制旋钮。确定项目时，按下 

[ENTER] 按钮。

4 选择装置名称
旋转控制旋钮选择需要的装置名称，然后按下 

[ENTER] 按钮。

如果显示 "Completed" (完成)，登录完成。

5 操作 <登录Bluetooth装置> (第26页) 的步骤，完成登
录 (配对)。

10Entry_stepup_M_CHS.indd   2610Entry_stepup_M_CHS.indd   26 10/01/08   11:0510/01/08   11:05



中文   |   27

 下载电话簿

将电话簿数据从手机下载到本机，以便于使用本机

的电话簿。

自动下载

如果手机兼容电话簿同步同能，在连接了Bluetooth

装置后，电话簿将自动下载。

⁄
· 可能要求进行手机的设定。

· 如果即使显示 "Completed" (完成) 但在本机仍未看到电话

簿数据，手机可能不支持电话簿数据的自动下载。对于这

种情况，请手动操作下载。

从手机手动下载

1 操作手机结束免提连接。
2 操作手机向本机传送电话簿数据
操作手机，向本机下载电话簿数据。

· 下载时显示: 

显示 "Downloading" (下载)。

· 下载完成后显示: 

显示 "Completed" (完成)。

3 操作手机开始免提连接。
清除下载完成信息

按下任何按钮。

⁄
· 对于每部登录的手机最多可以下载1000个电话号码。

· 每个电话号码可以最多登录32位号码、以及最多50*个表

示姓名的字符。

(* 50: 字符的数量。根据字符的类型，可以输入的字符可

能较少。)

· 请操作手机取消下载电话簿资料。

 登录PIN代码

操作Bluetooth装置，设定用于登录本机的PIN代码。

1 进入Bluetooth模式
 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [FNC] 按钮1秒钟以上。

显示 "BT MODE" (Bluetooth模式)。

2 进入功能设定模式
按下 [FNC] 按钮。

3 选择PIN代码编辑模式
可选择和确定以下项目。

"Settings" (设定) ➜ "Detailed Settings" ➜

"PIN Code Edit" 

选择项目时，旋转控制旋钮。确定项目时，按下 

[ENTER] 按钮。

4 输入PIN代码
操作分类 操作

选择号码。 旋转控制旋钮。

移动到下一位。 向右按下控制旋钮。

删除最后一位。 向左按下控制旋钮。

5 登录PIN代码
按下 [ENTER] 按钮。

如果显示 "Completed" (完成)，登录完成。

6 退出Bluetooth模式
按下 [SRC] 按钮。

⁄
· 初始值为 "0000"。

· 最多可以设定八位数字作为PIN代码。

取消Bluetooth模式

按下 [SRC] 按钮。

⁄
· 如果在列表中没有该装置名称，请选择 "Other Phones" (其

他手机)。
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Bluetooth设置
KDC-U7046BT/ KDC-U7046BTL/ KCA-BT200 (选购附件) 的功能

 选择需要连接的Bluetooth装置

如果已经登录了两台或更多台Bluetooth装置，需要选

择希望使用的Bluetooth装置。

1 进入Bluetooth模式
 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [FNC] 按钮1秒钟以上。

显示 "BT MODE" (Bluetooth模式)。

2 进入功能设定模式
按下 [FNC] 按钮。

3 选择Bluetooth装置选择模式
可选择和确定以下项目。

"Settings" (设定) ➜ "Phone Selection" (to select the 

cellphone) 或 "Audio Selection" (选择音响播放器) 

选择项目时，旋转控制旋钮。确定项目时，按下 

[ENTER] 按钮。

显示 "(名称)"。

4 选择Bluetooth装置
旋转控制 旋钮。

5 设定Bluetooth装置
向右或向左按下控制旋钮。

显示‘✱(名称)’或‘-(名称)’。

"✱" :  选择的Bluetooth装置占用。

"-" :  选择的Bluetooth装置待机。

"  " (空白):  Bluetooth装置的选择取消。

6 退出Bluetooth模式
按下 [SRC] 按钮。

⁄
· 如果一台手机已经被选择，请解除选择，然后选择其他手

机。

· 如果无法选择使用音响播放器的装置，请将该装置与音响

播放器连接。

 删除登录的Bluetooth装置

可以删除注册的Bluetooth装置。

1 进入Bluetooth模式
 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [FNC] 按钮1秒钟以上。

显示 "BT MODE" (Bluetooth模式)。

2 进入功能设定模式
按下 [FNC] 按钮。

3 选择Bluetooth装置删除模式
可选择和确定以下项目。

"Settings" (设定) ➜ "Detailed Settings" ➜

"Device Delete" 

选择项目时，旋转控制旋钮。确定项目时，按下 

[ENTER] 按钮。

显示装置名称。

4 删除选择的Bluetooth装置
旋转控制旋钮选择需要的装置名称，然后按下 

[ENTER] 按钮。

5 旋转控制旋钮选择 "YES" (是)，然后按下 [ENTER] 
按钮。

显示 "Completed" (完成)。

6 退出Bluetooth模式
按下 [SRC] 按钮。

⁄
· 登录的手机删除后，电话簿、通话记录、SMS和语音标签

也被删除。
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 显示固件版本

显示本机的固件版本。

1 进入Bluetooth模式
 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [FNC] 按钮1秒钟以上。

显示 "BT MODE" (Bluetooth模式)。

2 进入功能设定模式
按下 [FNC] 按钮。

3 选择Bluetooth固件升级模式
可选择和确定以下项目。

"Settings" (设定) ➜ "Detailed Settings" ➜

"BT F/W Update" 

选择项目时，旋转控制旋钮。确定项目时，按下 

[ENTER] 按钮。

显示固件版本。

4 退出Bluetooth模式
按下 [SRC] 按钮。

⁄
· 关于固件的升级方法，请浏览本公司网站。

www.kenwood.com/bt/information/

KCA-BT200 (选购附件)的功能

 添加语音拨号指令

向电话簿添加语音标签用于语音拨号。可以最多登录

35个语音标签。

1 进入Bluetooth模式
按下 [FNC] 按钮1秒钟以上。

显示 "BT MODE" (Bluetooth模式)。

2 进入功能设定模式
按下 [FNC] 按钮。

3 选择电话簿姓名编辑模式
可选择和确定以下项目。

"Settings" (设定) ➜ "Voice Tag" ➜ "PB Name Edit" 

选择项目时，旋转控制旋钮。确定项目时，按下 

[ENTER] 按钮。

4 搜索姓名进行登录
旋转控制旋钮选择姓名，然后按下 [ENTER] 按

钮。

如果已经对一个姓名登录了语音标签，则在该姓名

前显示 "*"。

5 选择模式
旋转控制旋钮。

显示 操作

"Register" 登录语音标签。

"Check"* 播放语音标签。

"Delete"* 删除语音标签。

* 只有当选择已经登录了语音标签的名称时显示。

选择 "Register" (登录)

6 登录语音标签 (第一次)
按下 [ENTER] 按钮。听到提示音后，请在2秒钟内

说出语音标签。

7 确认语音标签 (第二次)
按下 [ENTER] 按钮。听到提示音后，请在2秒钟内

再次说出相同的语音标签。

显示 "Completed" (完成)。

8 退出功能设定模式
按下 [  ] 按钮1秒钟以上。
返回至步骤2。可以继续登录其他语音标签。

⁄
· 如果语音没有被识别，则显示消息。(请参照 <故障检修> 

第36页)

按下 [ENTER] 按钮可以再次输入语音。

选择 "Check" (播放)

6 按下 [ENTER] 按钮。
播放登录的语音，返回至步骤2。

选择 "Delete" (删除)

6 删除语音标签
按下 [ENTER] 按钮。

7 旋转控制旋钮选择 "YES" (是)，然后按下 [ENTER] 
按钮。

退出Bluetooth模式

按下 [SRC] 按钮。
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Bluetooth设置
KDC-U7046BT/ KDC-U7046BTL/ KCA-BT200 (选购附件) 的功能

KCA-BT200 (选购附件) 的功能

 对分类设定语音指令

对语音拨号通话添加电话号码分类 (类型) 语音标

签。

1 进入Bluetooth模式
按下 [FNC] 按钮1秒钟以上。

显示 "BT MODE" (Bluetooth模式)。

2 进入功能设定模式
按下 [FNC] 按钮。

3 选择电话号码类型编辑模式
可选择和确定以下项目。

"Settings" (设定) ➜ "Voice Tag" ➜

"Detailed Settings" 

选择项目时，旋转控制旋钮。确定项目时，按下 

[ENTER] 按钮。

4 进入电话号码类型编辑模式
按下 [ENTER] 按钮。

5 选择需要设定的分类 (类型)
旋转控制旋钮选择需要的分类名称，然后按下 

[ENTER] 按钮。

"General"/ "Home"/ "Office"/ "Mobile"/ "Other" 

6 选择模式
旋转控制旋钮。

显示 操作

"Register" 登录语音标签。

"Check"* 播放语音标签。

"Delete"* 删除语音标签。

* 只有当选择已经登录了语音标签的名称时显示。

7 完成 <添加语音拨号指令> (第29页) 中的步骤6至8，
登录分类 (类型)。

8 退出Bluetooth模式
按下 [SRC] 按钮。

⁄
· 对全部5项分类设定语音标签。如果没有对全部分类登录

语音标签，可能无法通过语音指令呼出电话簿。
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SMS (短信服务)
KDC-U7046BT/ KDC-U7046BTL/ KCA-BT200 (选购附件) 的功能

 显示SMS 

在本机显示手机收到的短信。

显示新收到的短信。

¤
· 为了防止发生交通事故，驾驶人员在驾驶车辆时不得阅读

短信。

当新收到短信时

显示 "SMS Received" (收到短信)。

无论进行任何操作，该显示均消失。

显示SMS

1 进入短信收件箱模式
 KDC-U7046BT   KDC-U7046BTL 

按下 [ ] 按钮1秒钟以上。

 KDC-U6046   KDC-U6046L 

1)  按下 [FNC] 按钮1秒钟以上。

2)  按下 [FNC]按钮。

3)  可选择和确定以下项目。

"Settings" (设定) ➜ "SMS Inbox" 

选择项目时，旋转控制旋钮。确定项目时，按

下 [ENTER] 按钮。

2 选择短信
旋转控制旋钮。

每次按下 [ENTER] 按钮 ( KDC-U7046BT   KDC-U7046BTL )/ 

[DISP] 按钮 ( KDC-U6046   KDC-U6046L ) ，即在显示电

话号码或名称和短信接收日期之间切换。

3 显示文本
按下 [ENTER] 按钮。

旋转控制旋钮滚动显示短信。

按下 [ENTER] 按钮返回到短信列表画面。

4 退出Bluetooth模式
按下 [SRC] 按钮。

⁄
· 在列表的开头，显示没有打开的短信。其他短信按照接收

的顺序显示。

· 不显示手机未连接Bluetooth时收到的短信。下载SMS。

· 下载SMS时无法显示短信。

 下载短信

下载手机收到的短信 (SMS)，以便于在本机阅读。

1 进入Bluetooth模式
 KDC-U7046BT   KDC-U7046BTL 

按下 [  ] 按钮。

 KDC-U6046   KDC-U6046L 

按下 [FNC] 按钮1秒钟以上。

显示 "BT MODE" (Bluetooth模式)。

2 进入功能设定模式
按下 [FNC] 按钮。

3 选择下载短信模式
可选择和确定以下项目。

"Settings" (设定) ➜ "SMS Download" 

选择项目时，旋转控制旋钮。确定项目时，按下 

[ENTER] 按钮。

4 开始下载
按下 [ENTER] 按钮。

显示 "SMS Downloading" (短信下载)。

下载结束时，显示 "Completed" (完成)。

5 退出Bluetooth模式
按下 [SRC] 按钮。

⁄
· 手机必须能够使用Bluetooth传送SMS。可能要求进行手机

的设定。如果手机不兼容SMS功能，功能控制模式中的

SMS下载项目不显示。

· 从手机下载SMS时，手机中未打开的短信将被打开。

· 可以最多分别下载75条已读和未读短信。
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遥控器的基本操作

ATT

0 — 9

SRCVOL

FMAM

EXIT

5/∞

AUD

ENT

DIRECT

一般控制

· 音量控制: [VOL]
· 选择信号源: [SRC]
· 降低音量: [ATT]
再次按下该按钮时，恢复到先前的音量。

· 返回到前一个项目: [ ]
· 从模式中退出: [EXIT]
· 选择项目: [5]/[∞]
· 确定: [ENT]
· 进入音响控制模式: [AUD]

调谐器信号源

· 选择波段: [FM]/[AM]
· 选择电台: [4]/[¢]
· 呼出预设电台: [1] — [6]

CD/音响文件信号源

· 选择音乐: [4]/[¢]
· 选择文件夹: [FM]/[AM]
· 暂停/播放: [ENT]
· 进入音乐搜索模式: [5]/[∞]
· 音乐搜索模式时，在文件夹/文件之间移动: [5]/[∞]
· 返回到前一个文件夹: [ ]

iPod信号源

· 进入音乐搜索模式: [5]/[∞]
· 音乐搜索模式时，在文件夹/文件之间移动: [5]/[∞]
· 返回到前一项目: [ ]

免提手机控制

拨打电话

· 进入Bluetooth模式: [ ]
· 选择拨号方法: [5]/[∞] ➜ [ENT]
· 拨号输入: 

输入数字: [0] - [9]

输入 "+" : [¢]

输入 "#" : [FM]

输入 "*" : [AM]

清除输入的电话号码: [4]

· 拨打电话:  [DIRECT]

接听电话

· 接听电话: [ ]

通话等候

· 暂停当前的通话，接听其他来电: [ ]

在通话中

· 结束通话: [SRC]

遥控器的准备
沿箭头方向，从遥控器中拉出电池绝

缘片。

更换遥控器的电池
滑动

拉出
CR2025
(+极面)

请使用市售的纽扣型电池
(CR2025)。
根据电池盒内的标识，按照
正确的+、-极方向放入电
池。

¤ 注意

· 请将电池放在儿童拿不到的地方，并且在使用之
前不要打开原包装。请妥善处理旧电池。万一误
吞了电池，请立即与医生取得联系。

· 不得使电池靠近明火或放在直射阳光下。否则可
能导致火灾、爆炸或产生过热。

· 不要将遥控器放在仪表盘等较热的位置。

· 如果错误地更换锂电池，可能发生爆炸。仅限使
用相同或同等类型的电池更换。
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 附录 

 关于音响文件
· 可播放的音响文件
 AAC-LC (.m4a)、MP3 (.mp3)、WMA (.wma)

· 可播放的光盘媒体
  CD-R/RW/ROM

· 可播放的光盘文件格式
  ISO 9660 Level 1/2、Joliet、Romeo、长文件名
称。

· 可播放的USB装置 
  USB大容量存储器

· 可播放的USB装置文件系统
 FAT16、FAT32

虽然音响文件采用了上述标准，但是由于不同的媒体
或装置的形式或条件而可能无法播放。

· 音响文件的播放顺序
文件夹/文件分层例如下所示，文件按照从①至⑩
的顺序播放。

CD ( ) : Folder
: Audio fi
文件夹
音响文件

有关音响文件的在线使用指南可以从 www.kenwood.
com/cs/ce/audiofile/网站获得。该在线使用指南提供
了本使用说明书中没有记载的详细信息和注释。请务
必同时阅读在线使用指南。

⁄
· 在本使用说明书中，将闪存存储器和具备USB端子的
数字音响播放器称为 "USB装置"。

关于USB装置
· 如果本机电源接通，当USB装置与本机连接时可进
行充电。

· USB装置应安装在不影响正常驾驶车辆的位置。

· 无法通过USB集线器或多合一读卡器连接USB装
置。

· 使用本机时，请对音响文件备份。由于USB装置的
操作条件，音响文件可能被删除。
对于任何因删除存储的数据造成的损害，本公司不
承担赔偿责任。

· 本机不随机提供USB装置。请在市场上购买USB装
置。

· 建议使用CA-U1EX (选购) 连接USB装置。
使用非USB兼容连接线将无法保证正常播放。如果
连接线的总长度超过5m，将发生播放异常。

可与本机连接的iPod/iPhone
Made for 

• iPod nano (1st generation) • iPod nano (2nd generation)

• iPod nano (3rd generation) • iPod nano (4th generation)

• iPod nano (5th generation) • iPod with video

• iPod classic • iPod touch (1st generation)

• iPod touch (2nd generation)

Works with 

· 请将iPod/iPhone的软件升级到最新版本。

· 根据连接的iPod机型，可使用的控制类型有所不
同。有关详细内容，请浏览www.kenwood.com/cs/
ce/ipod/。

· 出现在本使用说明书中的 "iPod" 指使用iPod连接
线* (选购附件) 连接的iPod或iPhone。
*不兼容KCA-iP500。

· 关于可连接的iPod和iPod连接线，请浏览以下网
页。

 www.kenwood.com/cs/ce/ipod/

⁄
· 如果在连接了iPod后开始播放，则先播放由iPod播
放的音乐。
这时将显示 "RESUMING" 而不显示文件夹名称等。
变更浏览项目将显示正确的标题等。

· 如果iPod显示 "KENWOOD" 或 "✓"，则无法操作
iPod。
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关于 "KENWOOD Music Editor" 
· 本机支持电脑应用程序 "KENWOOD Music Editor 
Lite ver1.0" (KENWOOD音乐编辑器版本1.0)或更新
的版本。

· 使用由 "KENWOOD Music Editor Lite ver1.0" 添加
了数据库信息的音响文件时，可以通过 <音乐搜
索> (第9页) 按照标题、专辑或艺术家姓名搜索文
件。

· 在本使用说明书中，"音乐编辑器媒体" 指含有由
KENWOOD Music Editor添加了数据库信息的音响
文件的装置。

· "KENWOOD Music Editor Lite ver1.0" 可以从以下网
站获得:
www.kenwood.com/cs/ce/

· 有关 "KENWOOD Music Editor Lite ver1.0" 的详细
内容，请参照上述网站或该应用程序的帮助文件。

   KDC-U7046BT     KDC-U7046BTL 

 关于手机
本机符合以下Bluetooth标准: 

版本 Bluetooth标准版本 2.1 + EDR

配置文件 HFP (Hands Free Profile)
OPP (Object Push Profile)
PBAP (Phonebook Access Profile)
SYNC (Synchronization Profile)

有关已验证了兼容性的手机，请浏览以下网站: 

http://www.kenwood.com/cs/ce/bt/

⁄
· 对于支持Bluetooth功能的装置，按照Bluetooth SIG规
定的程序进行鉴定，证明符合Bluetooth标准。但是某
些型号的手机无法与这些装置通讯。

· HFP是用于免提通话的配置文件。
· OPP是用于在装置之间传送电话簿等数据的配置文
件。

   KDC-U7046BT     KDC-U7046BTL 

 关于Bluetooth音响播放器 
本机符合以下Bluetooth标准: 

版本 Bluetooth标准版本 2.1 + EDR

配置文件 A2DP (Advanced Audio Distribution Profile)
AVRCP (Audio/Video Remote Control Profile)

⁄
· A2DP是对音响播放器设计的传输音乐配置文件。
· AVRCP是对音响播放器设计的音乐控制播放和选择的
配置文件。

 附录 

10Entry_stepup_M_CHS.indd   3410Entry_stepup_M_CHS.indd   34 10/01/08   11:0510/01/08   11:05



中文   |   35

使用激光的产品标志 (部分地区除外)

 

1类激光产品

贴附在机架或外盒上的标记，是表示该产品使用了分
类为CLASS1激光的标志，表明本装置利用了最弱级
的激光束，并无向装置外辐射的危险。

· The Bluetooth word mark and logos are owned by 

the Bluetooth SIG, Inc. and any use of such marks 

by Kenwood Corporation is under license. Other 

trademarks and trade names are those of their 

respective owners.

· The “AAC” logo is a trademark of Dolby Laboratories.

· iPod is a trademark of Apple Inc., registered in the U.S. 

and other countries.

· iPhone is a trademark of Apple Inc.

· “Made for iPod” means that an electronic accessory 

has been designed to connect specifically to iPod and 

has been certified by the developer to meet Apple 

performance standards.

· “Works with iPhone” means that an electronic 

accessory has been designed to connect specifically 

to iPhone and has been certified by the developer to 

meet Apple performance standards.

· Apple is not responsible for the operation of this 

device or its compliance with safety and regulatory 

standards.

产品中有毒有害物质或元素的名称及含量

部件名称

有毒有害物质或元素

铅 
(Pb)

汞 
(Hg)

镉 
(Cd)

六价铬 
(Cr(VI))

多溴联苯 
(PBB)

多溴二苯醚
(PBDE)

安装基板 × ○ ○ ○ ○ ○

框架 × ○ ○ ○ ○ ○

机芯（硬盘驱动器、DVD、CD等） × ○ ○ ○ ○ ○

其他（附件） × ○ ○ ○ ○ ○

○： 表示该有毒有害物质在该部件所有均质材料中的含量均在 SJ/T11363-2006 标准规定的限量要求以下。

×： 表示该有毒有害物质至少在该部件的某一均质材料中的含量超出 SJ/T11363-2006 标准规定的限量要求。

表示例

该标识中表示的数字为自生产日期开始对环境的保护期限、表示不会因产品中含有的有毒有害物质或元素的外泄造成

环境污染、以及对人体或财产造成严重损害的年数。

该环境保护期限并不是对于性能、功能的保证期限。

在产品及电池等正常使用结束、进行废弃时，请遵守各地方政府的法律和规定予以处理。
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 故障检修

本机的某些功能可能由于对本机的某些设置而无效。

 !  ·  无法设定显示。
▲<功能设定> (第15页) 的 40 演示模式设定为关闭。 

 !  ·  无法设置低重音扬声器。
 ·  无法设定低通滤波器。
 ·  重低音扬声器无输出。

▲   <音响控制> (第7页) 的 "SubWoofer" (重低音扬声器) 
没有设定接通。

 !    无法设置重低音扬声器相位。
▲  <音响控制> (第7页) 的 "LPF SubWoofer ADJ" (重低音
扬声器低通滤波器调节) 设定为 "Through" (通过)。

有时被认为是故障的现象，其实是因微小的操作或配

线失误而造成。在要求维修之前，请参照下表检查可

能发生的问题。

共同

 ?  不发出按键操作核对音。
✔ 使用了预输出插口。

☞ 按键操作核对音无法从预输出插口输出。

调谐器信号源

 ?  广播的接收质量差。
✔ 没有伸展汽车天线。

☞ 全部伸展天线。

光盘信号源

 ?  不播放指定光盘，而播放其他光盘。
✔ 指定的光盘异常脏污。

☞ 请参照 <CD的使用> (第3页) 的清洁CD部分清洁
CD。

✔ 光盘划伤严重。
☞ 请使用其他光盘。

音响文件信号源

 ?  播放音响文件时发生跳音。
✔ 媒体擦伤或者肮脏。

☞ 参照 <CD的使用> (第3页) 的清洁CD部分清洁媒
体。

✔ 录制条件不良。
☞ 重新录制，或者使用其他媒体。

下列信息表示系统的状态。

TOC Error:  ·  光盘盒没有光盘。
 ·  光盘过于脏污。

光盘装入方向不对 (反面)。CD划伤严重。

Error 05:  无法读取该光盘。

Error 77:  因故不能正常运转。
➪ 按下本机的复位按钮。如果 "Error 77" 代
码不消失，请与当地的服务中心洽谈。

Error 99:  光盘盒发生了故障。或者本机由于某种原因
发生了故障。
➪ 检查光盘换片机。然后按下本机的复位按
钮。如果 "Error 99" 代码不消失，请与当
地的服务中心洽谈。

IN (闪烁):  CD播放部分没有正常运行。
➪ 重新插入CD。如果CD无法弹出、或者即使
正确地重新插入CD也依然闪烁，请切断电
源，与附近的服务中心洽谈。

Protect (闪烁): 扬声器导线短路、或与汽车底盘接触，保护
功能动作。
➪ 妥善布线或者绝缘扬声器导线，然后按下
复位按钮。如果 "PROTECT" 代码仍不消失
时，请与当地的服务中心洽询。

Unsupported File:
播放的音响文件格式本机无法使用。

Copy Protection: 播放了防止复制的文件。

Read Error:  连接的USB装置文件系统损坏。
➪ 再次向USB装置复制文件和文件夹。如果
仍然显示错误信息，请对USB装置进行初
始化处理或使用其他USB装置。

No Device: 虽然没有连接USB装置，但是选择了USB装置
作为信号源。
➪ 将信号源变换成为USB以外的其他信号
源。连接USB装置，然后再次变换成为USB
信号源。

N/A Device: ·  连接了不兼容的USB装置。
 ·  与iPod的连接失败。

➪ 请检查连接的iPod是否兼容。
 有关兼容的iPod详细信息，请参照 <关于
音响文件> (第33页)。
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No Music Data/Error 15:
·  连接的USB装置中没有可播放的音响文
件。

 ·  播放的媒体中没有记录本机可以播放的数
据。

USB ERROR: 某些故障可能发生在连接的USB装置方面。
➪ 拆除USB装置，然后将电源开关重新接
通。如果重复同样的显示，请使用另外的
USB装置。

iPod Error: 与iPod的连接失败。
➪ 拆除USB装置，然后再次连接。
➪ 请确认iPod的软件是否是最新版本。

USB REMOVE (闪烁):
对于USB/iPod装置选择了拆除模式。可以安
全地拆除USB/iPod装置。

No Number:  ·  来电对方未通报来电显示。
·  没有电话号码资料。

No Data: ·  没有拨出通话列表。
·  没有来电通话列表。
·  没有未接听电话列表。
·  没有电话簿列表。

No Entry:  手机没有登录 (配对)。

HF Disconnect: 本机无法与手机通讯。

HF Error 07: 无法使用存储器。
➪  切断电源然后再次接通。如果仍然出现该
消息，请按下控制装置的复位按钮。 

HF Error 68:  本机无法与手机通讯。
➪  切断电源然后再次接通。如果仍然出现该
消息，请按下控制装置的复位按钮。 

Unknown:  无法检测Bluetooth装置。

Device Full:  已经登录了5台Bluetooth装置。无法再登录
Bluetooth装置。

PIN Code NG: PIN代码错误。

Connect NG:  本机无法与该装置连接。

Pairing Failed: 配对错误。

Err No Matching: 
语音标签错误。由于未登录的语音标签等原
因，语音无法被识别。

Too Soft:  语音过轻，无法被识别。

Too Loud:  语音过响，无法被识别。

Too Long:  词句或说话过长，无法被识别。

No Phonebook: 数据没有包含在电话簿中。

No Message:  收件箱内无短信。

No Record:  语音标签没有在电话簿登录。

Memory Full:  语音标签的数量达到了可在电话簿中登录的
最大数量。

Favorite: No Memory: 
 该步骤没有向常用预设存储登录。

No Access:  常用控制的步骤预设无法使用。根据选择的
信号源或模式，预设内容可能无法呼出。

No Voice:   无通话。
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FM调谐器部分

频率范围 
200 kHz 间隔 :  87.9 MHz － 107.9 MHz
50 kHz 间隔 :  87.5 MHz － 108.0 MHz
可用灵敏度 (S/N = 30dB)
:  9.3dBf (0.8 μV/75 Ω)
静噪灵敏度(S/N = 50dB)
:  15.2dBf (1.6 μV/75 Ω)
频率响应 (±3 dB)
:  30 Hz － 15 kHz
信噪比 (单声道)
:  70 dB
选择性 (±400 kHz)
:  ≥ 80 dB
立体声分隔度 (1 kHz)
:  40 dB

AM调谐器部分

频率范围
10 kHz 间隔 :  530 kHz － 1700 kHz
9 kHz 间隔 :  531 kHz － 1611 kHz
可用灵敏度 (S/N=20dB)
:   28 dBμ (25 μV)

Bluetooth部分
(KDC-U7046BT/ KDC-U7046BTL)

版本
:  获得认证的Bluetooth版本 2.1 + EDR
频率范围
: 2.402 － 2.480 GHz
输出功率
:  +4dBm (MAX), 0dBm (AVE) Power Class 2
最大通讯范围
: 视线距离约10m (32.8英尺)
配置文件
: HFP (Hands Free Profile)
: HSP (Headset Profile)
: SPP (Serial Port Profile)
: A2DP (Advanced Audio Distribution Profile)
: AVRCP (Audio/Video Remote Control Profile)
: PBAP (Phonebook Access Profile)
: OPP (Object Push Profile)
: SYNC (Synchronization Profile)
: MAP (Message Access Profile)

CD播放机部分

激光二极管
:  GaAlAs
数字滤波器 (数/模) 
:  8倍取样
数/模转换器
:  24 Bit
心轴速度
:  500 － 200 rpm(CLV)
抖晃度
:  低于测量极限
频率响应 (±1 dB)
:  10 Hz － 20 kHz
总谐波失真 (1 kHz) 
: 0.008 %
信噪比 (1 kHz)
: 105 dB
动态范围
:  93 dB
MP3解码
:  MPEG-1/2 Audio Layer-3标准
WMA解码
:  Windows Media Audio标准
AAC解码 
:  AAC-LC ".m4a" 文件

USB接口

USB标准
: USB1.1/ 2.0 (全速)
文件系统 
: FAT16/ 32
最大供电电流
: 500 mA
MP3解码 
:  MPEG-1/2 Audio Layer-3标准
WMA解码 
:  Windows Media Audio标准
AAC解码 
:  AAC-LC ".m4a" 文件

音响部分

最大输出功率
:  50 W × 4
全带宽功率 (THD1％以下) 
:  22 W × 4
扬声器阻抗
:  4 － 8 Ω
音调
低音 : 100 Hz ±8 dB
中音 : 1 kHz ±8 dB
高音 : 12.5 kHz ±8 dB
预输出电平/负载 (CD)
: 2500 mV/10 kΩ
预输出阻抗
:  ≤ 600 Ω

技术规格
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规格可能会变更，恕不另行通知。

辅助输入

频率响应 (±3 dB)
:  20 Hz － 20 kHz
最大输入电压
:  1200 mV
输入阻抗
:  10 kΩ

共同

工作电压
KDC-U7046BT/ KDC-U7046BTL
 :  14.4 V (容许范围10.5 － 16V) 
KDC-U6046/ KDC-U6046L
 :  14.4 V (容许范围11 － 16V) 
最大耗电电流
:  10 A
安装尺寸 (宽 × 高 × 深) 
:  182 × 53 × 155 mm
重量
:  1.3 kg
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本象征标志表示，建伍公司制造的本产品

有利于减少对环境的有害影响。
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